Xilinx ISE 11.1 Simulation Tutorial

This tutorial provides a step-by-step guide to simulating a Verilog description of a 2-input AND gate using Xilinx ISE 11.1 —
11.4.

1. Start Xilinx ISE Project Navigator
Create a new project
*  Click on File, then choose New Project on the drop down menu
¢  Enter your project name, in this case the project is called “AND2gate”
¢ Choose your project location, this project is stored at “Z:\Projects\AND2gate”
¢ Leave the working directory entry blank.
*  Choose HDL as the source type from the Top-Level Source Type menu.
*  Click Next button

@ New Project Wizard

Create New Project
Specify project location and type.

Enter a name, locations, and comment for the project

Mame: Andzgate

Location: C:\Temp\Projectsiand2gate @
Working Directory: @
Description:

Select the type of top-level source for the project

Top-level source type:

HDL v

[ Next > H Cancel ]

3. You will be asked to select the hardware and design flow for this project.
*  For Family, choose Spartan3E
*  For Device, choose XC3S500F
¢ For Package, choose FG320
* For Speed, choose -4
*  For Simulator, choose ISim (VHDL/Verilog)
*  Click Next button



4. Next you are asked if you want to create new source files. We’ll add source files later so just click on the Next

button.

E New Project Wizard

Device Properties

Specify device and project properties.

Select the device and design flow For the project

Property Name Value

Product Category all v
Fanily Spartan3E v
Device |xCasso0e v
Package FG320 v
Speed -4 v
Top-Level Source Type IHDL

Synthesis Tool %ST {¥HDL/Verilog) v
Simulator 15im (VHDL¥erilog) v
Preferred Language Verilog v
Property Specification in Project File Store non-default values only v
Manual Compile Order O

Enable Enhanced Design Summary

Enable Message Filtering O

Display Incremental Messages O

’ < Back ]I Next > ][ Cancel ]

E New Project Wizard

X]

Create New Source

‘You may optionally create one source at this time. You can add existing sources on the next page, and later create
additional sources with the "Project->New Source" command.

Create a new source

Source File

Type

Mew Source...

Remove

[ < Back ]l Next > I[ Cancel




5. You are asked if you want to add existing source files. Since we have a new project we don’t have any existing files.
Additionally, if you did have pre-existing files, you can also add these to the project later. Click on the Next button.

B New Project Wizard

Add Existing Sources
Adding existing sources is optional. Additional sources can be added after the project is created using the "Project-
=Add Source" or "Project->Add Copy of Source" commands.

Add existing sources

Source File Copy to Project Add Source

[ < Back ][ MNext > ][ Cancel ]

6. A project summary will appear. Click on the Finish button.

= New Project Wizard

Project Summary
Project Mavigator will create a new project with the following specifications.

Project:
Project Nawe: And2gate
Project Path: C:%Tenmp\Projects\AindZgate
Working Directory:
Description:
Top Level Source Type: HDL

Device:
Device Family: Spartan3E
Device: xc3s500e
Package: fg320
Speed: -4

Synthesis Tool: XST (VHDL/Verilog)

Simulator: ISim (VHDL/Verilog)

Preferred Language: Verilog

Property Specification in Project File: Store non-default wvalues only
Manual Compile Order: false

Enhanced Design Swmmary: enabled
Message Filtering: disabled
Display Increnmental Messages: disabled

[ < Back ][ Finish I[ Cancel ]




7. You now have a project by the name of “AND2gate”. Next you want to specify the files in this project are for

behavioral simulation.
¢ Click on the Sources for: drop down menu, choose Behavioral Simulation

Choose [ A\Te :
“BehaViOl‘al File Edit View Project Source Process Tools ‘Window Help |

Simulation” NQ @ HO [ w D% o o s

Design & X

Sources fol

v
Hierarchy Ead
' And2gate E
= €3 xc3s500e-4fg320
i Mo design modules are cu

MNext Steps:
+ . - Create new sources f

< : I

Mo single design module is selected.
& % Design Utiities

A8 88V |« i BEE

Design [ Files “ Libraries l

Console o0& X

< 11l

Console l Errors " Warnings " Find in Files Results I

8. Now we want to add a new file to our project.
*  Click on Project, choose New Source
*  Choose Verilog Module as the file type
* In the File name: box enter the desired file name, in this case the file is named “and2gate.v”

*  Click on the Next button

@m1
Select Source Type
Select source type, file name and its location.

. IP (CORE Generator & Architecture Wizard)
(0] Schematic

=] User Document

Verilog Module

4] verilog Test Fixture

g VHDL Module )
[ vHDL Library Bleleney

[P] ¥HDL Package | andZgate.v |
g VHDL Test Bench

¢'| Embedded Processor

Location:
| C:\TemplProjects\And2gate l Q

Add to project

I Next > I[ Cancel ]




9. You will be asked for the module’s port names/types. You can skip this step and click on the Next button.

= New Source Wizard %]

Define Module
Specify ports for module.

Module name ‘ and2gate

Port Name Direction Bus MSEB LSB
{input |
input v
input: v
input v
input: v
input v
input v
input v
input ~O
input v
input: v
input: v

[ < Back H Next = ][ Cancel

10. A project summary will appear. Click on the Finish button.

E New Source Wizard ﬁ

Summary
Project Navigator will create a new skeleton source with the Following specifications.

Add to Project: Yes

Source Directory: C:\Temp\Projectsiand2gate
Source Type: Verilog Module

Source Name: and2gate.v

Module name: and2gate
Port: Definitions:

[ < Back ][ Finish ][ Cancel




11. The “and2gate.v” file has been added to your project.

ISE Project Navigator - C:\Temp\Projects\And2gate\And2gate. xise - [and2gate.v]

M=%

@ File Edit View Project Source Process Tools Window Help - 8 X
DR L %DOX v MG AAPXXAR[A2EOiLipQ
Design «0& xl E 1 “timescale 1ns / 1ps ‘_ﬁ
[ | Sources for: Behavioral Simulation \E] 4 2 SEIPESEEERE TSR RSP RIS EE R RR SRR ESR R R
N o 3 // Company:
@ fererciv = 4 // Engineer:
EE] I E Anngte s /7
| 9 3 xe3s5aemdiaqzo ) 6 // Create Date:  07:28:15 01/27/2010 |
uh ' ' TempiProjects| 7 // Design Name: 3
[13 2 -9 8 // Module Nawe: and2gate
anngate-V ;ﬁ' 9 // Project Name:
added tO v <] T} | (> 4 10 // Target Devices:
= e— % 11 // Tool versions:
proj ect > | Processes: and2gate 4 12 // Description: b |
® % I5mSimulator A T
gf: *% 14 // Dependencies:
X 15 //
16 // Revision:
5’{: 17 // Revision 0.01 - File Created s
Ixs Atrdiana Awmant o . —
1 ><] 13\ | o v [)]
Design | Fies | Libraries | B andzgate.v |
Console 08 X
Started : "Launching ISE Text Editor to edit andZgate.wv"”.
< I 1) [L]

Console ‘ Errors H Warnings ” Find in Files Results ‘

Ln1cColl Verilog -

12. Click on the and2gate.v tab to show the file contents. You are now ready to specify the and2gate module’s
functionality.

ISE Project Navigator - C:\Temp\Projects\And2gate\And2gate. xise - [and2gate.v]

M=%

Click on

“and2gate.v”
tab T~

>- workspace

@ File Edit View Project Source Process Tools Window Help - | & X
DEP L %DDX we W@ APXX AR [N 2B DL ip-Q
Design «0& xl E 1 “timescale 1ns / 1ps
[ | Sources For: Behavioral Simulation \E] 5 2 SEPPESESEIE IR RSP RS R SRR RS
Hi h o 3 // Company:
E@ Life ) = 4 // Engineer:
& ] andzgate ~ s /7
~— | @ £ xc3s500e-4fg320 | = 6 // Create Date:  07:28:15 01/27/2010 |
o and2gate (C:\TempiProjects} 7 // Design Neme: 3
3 8 // Module Name: and2gate
@ 9 // Project Name:
v <] 1l | (> 4 10 // Target Devices:
= e— % 11 // Tool versions:
> | Processes: and2gate 4 12 // Description: b |
® % I5mSimulator A T
X *% 14 // Dependencies:
x: 15 //
16 // Revision:
5’{: 17 // Revision 0.01 - File Created 54
\ 10 fAAATrianal Crwmantos adl
) (]
Design | Files V Libraries ‘
Console 08 X
Started : "Launching ISE Text Editor to edit andZgate.wv"”.
< I fm | [L]

Console ‘ Errors H Warnings ” Find in Files Results ‘

Ln1cColl Verilog -




13. Notice that the ISE has already entered a comments sections along with a couple of lines of code for us.

* The line “*timescale 1ns/ 1ps” is located at the top of the file. The Verilog language uses dimensionless time
units, and these time units are mapped to “real” time units within the simulator. “timescale is used to map to the
“real” time values using the statement ‘timescale <timel> / <time2>, where <time1> indicates the time units
associated with the #delay values, and the <time2> indicates the minimum step time used by the simulator.

¢ The and2gate module is also declared using “module and2gate();” and “endmodule”, but the ports are left for us
to define.

¢ We finish specifying the functionality of the and2gate module as shown below.

b= ISE Project Navigator - C:\Temp\Projects\And2gate\And2gate. xise - [and2gate.v] - ...
@ File Edit View Project Source Process Tools Window Help - | & X tlmescale 1nS/ lps
o2 = db B RN N PPl R (A B B A F » »

Design +08 X < 1 Tilescale 1ins 7 1ps mOdUIe andzgate(A’ B’ F)’
[| | Sources for: Behavioral Simulation v §= 2 |npUt A, B,

P — 3 Jwodule and2gateil, B, F): .

(2] | Hierarchy 2 input A, B; output F;

iy Andzgate B 5 ocutput F reg F;

=1 £3 xc3s500e-4fg320 6 reg F:
and2gate (C:\TempiProjects), 2
& 8 alvays @ (&, B) always @ (A, B)
9 begin be in
v < > A 10 F <= L & B; g
% 11 end F<=A & B,
Processes: and2gate 12 endmodule
o * ’y 1Sim Simulator » 13 end
% endmodule

{

A

m < >

Design | Files | Libraries @ and2gate.v
Console 08 X

Started : "Launching ISE Text Editor to edit and2gate.v".
< >
Console Errors | Warnings | Find in Files Results
Ln13Col1 Verilog




14. We also want to add a test bench and again follow Steps 8 — 11 to add “and2gate tb.v”. Then we add the
functionality of the testbench module as shown below.

=4 ISE Project Navigator - C:\Temp\Projects\And2gate\And2gate. xise - [and2gte_tb.v] E]@ x* *timescale 1ns / 1pS
@ File Edit View Project Source Process Tools ‘Window Help X
na DX v MEIALEKXAR|[A BB OO LaP > Q module and2gate_tb();
Design <08 X & 1 | timescale 1ns / 1ps o reg A_t, B_t,
[ Sources for: Behavioral Simulation ~v| p= 2 . .
) N — 3 fJwodule andzgate thi): wire F_t,
& Hierarchy a reg A t, B t
= ] andzgate .: 5 wire F l,:; -
| o & cassovetoszo x| ° a and2gate and2gate_1(A_t, B_t, F_t);
5 * and2gate_tb (C:\TempProjec 7 andzgate and2gate_1(i t, B_t, F_t):
= o g s
S 5 initial initial
v <] > A4 | 10 begin begin
% 11
> | Processes: and2gate_tb 12 // case 0
o | ® % ISim Simulator % 13 A _t<= // case 0
i 5| 12 41 = v, Ft)
<L 15 A _t<=0; B_t<=0;
16 /i case 1 H n VAN .
A 0 A t<=0; B_t<mi; L #1 $display("F_t = %b", F_t);
410 P P PP DY 1 T SN S S U
m <] >
— : // case 1
Design Files | Libraries @ and2gate.v @ and2gte_tb.v
— 5% A _t<=0; B_t<=1;
onsale .
#1 $display("F_t = %b", F_t);
Started : "Launching ISE Text Editor to edit andZgate.wv"”.
Started : "Launching ISE Text Editor to edit andZgte_th.v". // case 2
A_t<=1; B_t<=0;
#1 $display("F_t = %b", F_t);
<l // case 3
Console Errors | Warnings | Find in Files Results A_t<=1; B_t<=1;
Add a new source to the project Ln 12 Col 16 Yerilog #1 $d|Sp|ay("F t = O/Ob", F t);
end
endmodule




15.

Expand the ISim Simulator menu, double click on Behavioral Check Syntax
If the syntax was correct, a checkmark appears beside the Check Syntax menu
If the syntax was incorrect, the window at the bottom will list the individual errors.

~

b= ISE Project Navigator - C:\Temp\Projects\And2gate\And2gate .xise - [and2gte_th.v]

After saving both “and2gate.v”” and “and2gate tb.v”, we want to check the syntax of both files.

-

M=%

Expand ISim
Simulator menu,
double click on

Behavioral Check

Syntax

Any errors will
be listed here

@ File Edit View Project Source Process Tools Window Help = | & X
DPEP L[ %00X v MG AARXX AR (N =B D[ L9
Design «08&8 X = 1 ‘timescale 1lns / 1ps N
| | Sources for: Behavioral Simulation | v| = 2
<1 | vierarchy 3 module andZgate_th():
=l 4 reg A t, B_t;
"}ﬂ And2gate 9 5 wire F t;
= £ xc3s500e-4fg320 6 - =
b | Y] and2gate th (C\Temp\Frojeg 7 andzgate andzgate_1(A_t, B_t, F_t):
= 2 8
éJ 9 initial
\ > A 10 begin
— o 11
5 4
v 12 // case 0
o
= A a3 A_t<=0; B_t<=0:
{: % 14 #1 $display("F_t = %b", F_t):
4N 15
16 // case 1
& 17 A _t<=0; B_t<=1;
p— 10 #1 QAiomlanmifF + = 217 B ). V\
<] [2]
Design Files Libraries @ and2gate.v @ and2gte_tb.v
We 08 X
vlogoomp 'A"
termining compilation order of HDL files
Parsing Verilog file "C:/Tewp/Projects/ind2gate/and2gate.v"” into library isim temp
Parsing Verilog file "C:/Tewp/Projects/And2gate/and2gte_tb.v" into library isim tewp
Parsing Verilog file "C:/Xilinx/11.1/ISE/verilog/src/glbl.v" into library isim_temp )
eck Syntax" completed successfully
=
<] >
Console | Errors | Warnings | Find in Files Results
Ln 14 Col 36 Verilog

16. Now it’s time to simulate the design.
¢ Double-click on the Simulate Behavioral Model icon

=4 ISE Project Navigator - C:\Temp\Projects\And2gate\And2gate .xise - [and2gte_tb.v] E]@
@ File Edit View Project Source Process Tools Window Help - |8 X
DEEP S8 DX wa MR APALEXXARIIA:TZTB ML »:Pp»Q
Design +08d X| & 1 timescale 1lns / 1ps (o]
. [ | Sources for: Behavioral Simulation v| p= 2
Double-click on o] | Herercy | 3 wodule andzgate_th():
,ﬂ Andzaat = X reg A t, B_t;
“Qj A (=] Andegate o 5 wire F _t;
Slmulate del = €3 xc3s500e-4fg320 = 6 - =
BehaVioral it * andzgate_th (C:\Temp!Projed 7 andZgate and2gate_1(i t, B_t, F_t):;
= 2 8
MOdel” & 9 initial
M L| m L| A 10 begin
% 11
\Processes: and2gate_tb 12 /{ case 0
* ISim Simulator A 13 A_t<=0; B_t<=0;
I?t 3 >4 14 #1 §display("F_t = %b", F_t):
x4 15
16 // case 1
I'E”t Simulate Behavioral Model A t<=0; B_t<=1;
- = H1 GdiemiamiME r o= Shr R oeis v
n ramT B
Design | Files | Libraries @ and2gate.v @ and2gte_tb.v
Console <08 X
Running vlogcomp N
Determining compilation order of HDL files
Parsing Verilog file "C:/Temp/Projects/Aind2gate/and2gate.v" into library isim_temp
Parsing Verilog file "C:/Temp/Projects/And2gate/and2gte_th.v" into library isim_temp
Parsing Verilog file "C:/Xilinx/11.1/ISE/verilog/src/glbl.v" into library isim tewmp
Process "Check Syntax" completed successfully
o
<] ! >
Console Errors Warnings Find in Files Results
Ln 16 Col 16 Verilog




17. The ISim Simulator open in a new windows displaying a waveform and run a default simulation for some number of
time units. We can now check the and2gate module’s functionality. Further, the $display statements included in the
testbench appear in the lower window.

3 1Sim - [Default.wefg*] _Io
b File Edit View Simulation Window Help 18l x
024 A DDOX® v 24 8 HH O AN DA A2 Riwa| § 1 B b pZ 1.00us (v Gz »

Instance.. «#+ O & X Objects «+08 X

5, Simulation Objects for ...

@l @ ® >
Instance and Process |

and2gate_tb | Object Mame

£ bl B Ft
b At
b Bt
< >
Instan... Sour... < > | =8 Default.wcfg*
Console 085 X

ing circuit initialization process. ~
itialization process.

nished circuil
=0

Console oints Find in Files Results Search Results
Sim Time: 1,000,000 ps

$display statements appear here




18. To view the beginning of simulation, click on the Go To Time 0 button.

ISim - [Default.wcfg*]
i File  Edit  View

D2 d o X® v
tance... +» 0 & X Objects «+08 X
Simulation Objects for ...

Simulation  Window  Help

Click on
“GoTo
Time 0”

&4 (2

>»

Instance and Process |
and2gate_th = Object

1} abl B FL o
At

< >

Instan... Sour... < > Default.wefg*

Console

Simulator is doing circuit initialization process.
Finished circuit initialization process.
Ft=0

Ft
Ft
Ft

o
- 0o

1Sim>>

Console Breakpoints Find in Files Results Search Results

Sim Time: 1,000,000 ps

19. We can now see the simulation waveform for the beginning out our simulation.

ISim - [Default.wcfg*]

@5 File Edit View Simulation Window Help
O2d dDDODX® v 4 (28 HEH OGN 22X 2
‘Instance... +«+ 0O & X Objects «+08& X

= .|y Simulation Objects for ...
=l g

| S| & 1 >»
Instance and Process | i)l @ X
and2gate_tb = Object Name
) gbl @ Ft
o ©
) B_t J
o]
=r
i
< >
Instan... Sour... < > ET Default.wcfg*
Console
Simulator is doing circuit initialization process.
Finished circuit initialization process.
Ft=0
Ft=0
Ft=0
Ft=1
ISim>
Console Breakpoints Find in Files Results Search Results

Sim Time: 1,000,000 ps




20. To control the simulation time, we can restart the simulation and simulation for a specific length of time. Either click
on the Restart button or select Restart from the Simulation menu. We will now have an empty waveform.

8 ISim - [Default.wcfe*]
Fad File  Edit
O2H db L X® v
Instance... «+ O & X Objects <08 X
Simulation Objects for ...

View Simulation Window Help

Q

0 2 =]

=G »

»
1| S| mal| @
Instance and Process |

and2gate_tb

1 bl

Object Name
@Ft
) At
) Bt

< >

Sour... < > | | B Default.wefg*

Instan...

Console
£

F
F
F

o
ocoo

"t
_t
Ft=1
ISim>
# restart
1Sim>>

Console Search Results

Breakpoints Find in Files Results

Sim Time: 0 ps

21. To simulate for a specific length of time, enter the desired simulation time and click on the Run for the time

specified in the toolbar button. In our case, we want to simulate for 10 ns.

5 1Sim - [Default.wefg*]
Edit Window  Help
l : 4 - db I X® ©
‘Instance“. <+ [0 & X Objects 08 X

5, Simulation Objects for ...

kil File View  Simulation

»

1 (10 [
Instance and Process | IR )
and2gate_tb =~ Object Name
14 gbl @ Ft
) At
) Bt
< >
Instan... Sour.. < > Default.wcfg*
Console
Simulator is doing circuit initialization process.
Finished circuit initialization process.
Ft=0
Ft=0
Ft=0
Ft=1
ISim>
Console Breakpoints Find in Files Results Search Results

Enter the simulation time and click on “Run for...”

Sim Time: 10,000 ps



